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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Universal Work Queue User Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Universal Work Queue.

If you have never used Oracle Universal Work Queue, Oracle suggests you 
attend one or more of the Interaction Center training classes available through 
Oracle University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle 
Universal Work Queue.

■ Chapter 1, "Product Description", provides overviews of the application and its 
components, explanations of key concepts, features, and functions.

■ Chapter 2, "User Procedures", provides process-oriented, task-based procedures 
for using Oracle Universal Work Queue to perform essential business tasks.
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Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Universal Work Queue.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Oracle Universal Work Queue shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Universal Work Queue.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.
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If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Universal Work 
Queue (and any other Oracle Applications products). This guide also includes 
information on setting user profiles, as well as running and reviewing reports and 
concurrent processes.

You can access this user’s guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Universal Work Queue Implementation Guide
Use this guide to implement and administer Oracle Universal Work Queue.

Oracle Advanced Inbound Implementation Guide
Use this guide to implement inbound media for an interaction center.

Oracle Advanced Outbound Implementation Guide
Use this guide to implement outbound media for an interaction center.

Oracle Scripting Implementation Guide
Use this guide to implement Oracle Scripting.

Oracle Interaction Center Server Manager Implementation Guide
Use this guide to implement Interaction Center Server Manager.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
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also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.
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Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Universal Work Queue 
working for you. This team includes your Technical Representative, Account 
Manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle8i server, and your hardware 
and software environment.
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OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.



xv

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Product Descr
1

Product Description

This chapter describes the features and architecture of Oracle Universal Work 
Queue. It also describes the concepts required to understand the implementation 
and administration tasks. The concepts also appear in the product online help.

Topics include:

■ Features

■ Concepts

1.1 Features
Universal Work Queue is a flexible work presentation and access framework that 
provides a centralized view and access to interaction center work. From the 
Universal Work Queue desktop, a user can access and update work items. Work 
that originates from a customer contact channel, such as a telephone call or an 
e-mail, is considered a media work item. Work which originates from an Oracle 
Application, such as a task or lead, is called an application work item. You can set 
up Universal Work Queue to handle both application and media work items, or 
only application work items. 

See Also
■ Concepts

1.1.1 Oracle Universal Work Queue Features
The features of Oracle Universal Work Queue include:

■ Oracle Universal Work Queue desktop interface

■ Oracle Universal Work Queue server
iption 1-1



Concepts
■ Oracle Universal Work Queue application integration bean

■ icWork Controller

■ Prioritized work delivery

■ Application notices

■ Application and interaction integration

■ Session information

■ Administration, configuration, and diagnostics

By providing a single point of access for all agent work, Universal Work Queue 
minimizes the complexity of agent interactions across multiple contact channels and 
across Oracle Applications. Agents interact with application and media work 
through a consistent interface. 

Universal Work Queue also provides a standard programming interface for Oracle 
Applications and media enablers to request, receive, and display agent work 
information. Work providers use this framework for the delivery and presentation 
of work items to agents for processing. The customer channel framework includes 
the support for multiple and simultaneous interactions. For example, handling an 
unsolicited call while processing another interaction type. Simultaneous interaction 
handling and processing is reliant on the framework being supported by the work 
provider.

Through integration with Oracle Interaction Blending, agents are moved between 
media queues based on service levels for the interaction center.

1.2 Concepts
Universal Work Queue is an interface for accessing, organizing and acting upon 
different types of work generated in an interaction center. Work that originates from 
an Oracle Application, such as a service request or task is called an application 
work item. Work that originates from a customer contact channel, such as a 
telephone call is called a media work item. 

You can select a customer channel and request work from it; this sets you available 
for the next media item that is in the queue for you. You can select and open an 
application work item. When Oracle Universal Work Queue delivers a work item, it 
launches the appropriate business application form.

Concepts include:

■ Agent Workplace
1-2 Oracle Universal Work Queue Implementation Guide
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■ Work Selector

■ Quick Filters

■ Work Summary Panel

■ Work Panel

■ Interaction Center Work Controller - icWork

■ Worklist

■ Softphone Tab

■ Notice Tab

■ Interaction Blending

■ Refresh Strategy

■ Phone Extension Window

■ Screen Pop

■ Work Assignment

■ Work Delivery

■ Navigating Oracle Universal Work Queue

See Also
■ Features

1.2.1 Agent Workplace
The agent workplace provides a single point of access for all interaction center 
work.  Within the workplace you may view, organize, act upon and open your 
work.  The workplace is designed so you may quickly focus on a broad overview of 
your workload, a list of work item summaries or the details of individual work 
items.  You may configure your agent workplace to display information to best suit 
your work style.

The agent workplace is divided functionally into five major sections: workplace 
configuration and work access controls, work selector, quick filters, work summary 
panel, and the work panel.
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1.2.1.1 Workplace Configuration and Work Access Controls
The workplace provides special menu options and toolbar icons that allow you to 
configure the workplace and control work items selected within the workplace.

Configuration Controls Using profile options, you, your supervisor or your site 
administrator may determine which work item types and customer channel sources 
are always available.  From within the workplace you may also change the work 
selector style (either as a tree along the left side of the workplace or as a cascading 
menu at the top).  From the tree work selector you may:

■ show or hide node counts

■ show, hide or set the display order of work nodes

■ refresh individual nodes or subindex

Work Access Controls Work Access Controls allow you to you to request work 
from a selected customer channel or open a selected work item.  You may also 
request, reschedule or complete work from the Worklist.  There are work access 
controls that quickly clear or reset the Quick Filters, to refresh work information, 
and to reset the current application and customer channel interaction state.

1.2.2 Work Selector
Use the Work Selector to review your workload and select a work source.  The Work 
Selector provides an overview of your workload; it is organized into work source 
nodes by application work type (such as Tasks, Leads, Service Requests, etc.) and 
customer channel source (such as Inbound Telephone calls, Outbound Campaigns, 
eMail, etc.)  Some nodes comprise more specific work item types such as “My 
Leads” or “My Teams Leads”.   Most nodes are further segmented into sub-nodes 
by attributes, such as application work type status, age or ownership.  Some nodes 
have several sub-node segmentation tiers.

The tree work selector displays along the left side of the Work Place.  It provides a 
quick overview of workload and its organization.  The tree selector also enables you 
to turn counts on and off and to control the display and order of nodes. 

The cascading work selector displays as a drop down menu at the top left of the 
Work Place, just below the menus and toolbars.  It is more compact and affords a 
great display area for the work summary panel.  While it does not provide a 
complete hierarchy of all work items, it is more compact and somewhat easier to 
navigate.  
1-4 Oracle Universal Work Queue Implementation Guide
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Use the Switch Work Selector control or menu option to toggle between the tree and 
cascading work selector display styles.  The profile option IEU: Desktop: UI: Work 
Selector Display Style sets the default Work Selector display style; HGRIID displays 
the tree work selector and CASCADE displays the cascading work selector.

1.2.3 Quick Filters
Use Quick Filters to further refine and narrow the focus of work items displayed in 
the work summary panel beyond the seeded work node segmentations.  Not all 
application work item types support quick filters, and your administrator must 
configure your responsibility and nodes to activate quick filters.  

When present, quick filter controls display across the top of the Work Place, just 
below the menu and toolbars and to the right of the cascading work selector.  Use 
the drop down filter control to set the attribute filter values, then press the Quick 
Filter apply button at the far right of the quick filter area.  Once applied, Quick 
Filters remain in effect for the duration of the current session or until you change 
them; Quick Filters revert to the default setting at the start of each session.

Administrators may set a default Quick Filter value for each quick filter attribute.  
Use the “Default Filter” control or Tools->Default Filter to revert to the node’s 
default Quick Filters.  Use the “Clear Filter” toolbar icon of the Tools->Clear Filter 
to remove the current node’s filters and view all work items unfiltered.

1.2.4 Work Summary Panel
The Work Summary Panel is a table that lists and presents summary information 
about each work item in the current selected. (Quick Filters may further refine the 
work items listed.)  The Work Summary Panel displays to the right of the tree work 
selector and below the cascading work selector and the Quick Filters selection 
controls.

The Work Summary Panel is always present whenever a node is selected.  When 
Oracle Universal Work Queue starts, there is no selected node; therefore the Work 
Summary Panel is empty (blank).  If the Work Summary Panel is empty:

1. Check to be sure you have selected the node.

2. Check the counts and make sure there is work in the selected node or sub-node.

3. Check the applied Quick Filters, some Quick Filter combinations may not 
include any work (for example filtering on "closed" status).

Use the Work Summary Panel to review current work items, select, open and act on 
one work item or select and act upon two or more work items:
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■ Select one work item

■ Select and open a work item

■ Select two or more work items

You may customize the work summary panel in the following ways:

■ Hide or display attributes (columns)

■ Set the order of columns in the table

■ Sort the list work items on one, two or three attributes

■ Save your customized settings

■ Clear saved customized settings

Use Quick Filters to further refine and narrow the focus of work items displayed in 
the work summary panel beyond the seeded work node segmentations.  Not all 
application work item types support quick filters, and your administrator must 
configure your responsibility and nodes to activate quick filters.  

1.2.5 Work Panel
Use the Work Panel to perform quick actions on the selected work item(s). It 
presents additional information in the form of special instructions, extended 
information, and detailed information about the work item selected in the Work 
Summary Panel.

When present, the Work Panel displays in the lower half of the Work Place form, 
beneath the tree work selector and the Work Summa Panel. Not all nodes support 
the work panel; some application work item types do not support the work panel 
and your administrator may configure nodes to access the Work Panel.

The Work Panel is divided into three areas:

Note: Each attribute may be independently sorted in ascending or 
descending order.

Note: Saved settings last between session until you either change, 
save, or clear the new or customized settings.
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■ Special Instruction Area - this displays special instruction based on work item 
attributes such as "customer is in collections." The objective is to present 
additional information to help you better understand the work item and if and 
how you should act upon it.

■ Extended Information Area - this displays additional information gathered 
from other sources and linked together. This provides access to large amounts 
of information such as notes.

■ Action Area - this allows users to select and execute actions on the selected 
work item(s). It presents additional details and allows users to enter or change 
parameter values. The actions listed vary depending on the work item, the node 
configuration and the number of work items selected. The details and 
parameters vary depending upon the selected action, the node configuration 
and the number of work items selected.

1.2.6 Interaction Center Work Controller - icWork
icWork provides a "remote control" for work. It is an independent window with a 
small footprint that provides interaction and work control, such as the softphone, 
interaction control and notices. icWork can be positioned anywhere on the screen. 
Use the icWork menu and toolbar options to control your work state; you may 
request work or breaks, complete or reschedule. It provides information about 
current active interactions; and has a tabbed area that imbeds media controllers, 
such as the softphone and the notices control.

icWork is only enabled and present if you are enabled for one or more of the 
following:

■ If any customer channel node is enabled - inbound or outbound telephony. For 
example, used to cancel and request queued media work and to control media 
items through the embedded softphone.

■ If the Worklist is enabled. For example, used to request the next work item, 
reschedule work and complete work.

■ If session tracking is enabled. For example, used to request a break.

■ If application notices are enabled. For example, used to read, acknowledge, 
delete and navigate through notices.

1.2.7 Worklist
The Worklist provides queued access to application work items ordered by priority 
and scheduled start date.  Each work item is assigned a standard priority.  The 
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Worklist can combine work of all types, although not all work items support the 
worklist.  Currently you may only access Tasks through the Worklist. 

Use the Work Place or icWork menu and toolbar options to:

■ Request the next Worklist item

If you have an open Worklist item, it is closed and a new work item is launched 
into the appropriate application.

■ Reschedule a Worklist item

This will pop up a control you may use to defer the worklist item. From the 
reschedule control you may also request the next worklist item or complete 
worklist work.

■ Complete Worklist

Return and close the current worklist item and stop receiving work from the 
worklist.

1.2.8 Softphone Tab
The softphone allows users to view call information and to control the call. Use the 
softphone to:

■ Initiate a call (dial a number)

■ Answer an inbound call (Your phone may be configured for "auto answer". If it 
is you do not need to answer incoming calls.)

■ Place an active call on hold

■ Hang-up an active call

■ Transfer a call to another agent

■ Conference another agent into an existing call

■ View call information such as call classification or campaign, customer 
information or IVR activities.

■ View call state, for example, which line is ringing on hold, etc.

1.2.9 Notice Tab
Notices inform users about important events. For example, application work items 
can send a notice when a work item is assigned, a customer updates a work item 
through a self-service application, or when a work item closes.
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The Notice Control allows you to:

■ Read notices

■ Acknowledge notices

■ Close a notice (no longer appears in the Notice control)

■ Filter notices by age (e.g., all new notices, today’s notices)

■ Check for new notices ("refresh")

■ Navigate forward, backward, to the beginning or end of the current notice list 
(based on the applied filter)

1.2.10 Phone Extension Window
If you are enabled for media work, then the Phone Extension window may appear 
when you start Universal Work Queue. If the Phone Extension window appears, 
enter the teleset number for the teleset and then click OK.

1.2.11 Screen Pop
A screen pop presents a fully populated application form or search screen based on 
media (call) information. Because the screen pop and phone call arrive nearly 
simultaneously you can begin helping the customer almost immediately. Oracle 
Universal Work Queue works with the application and customer channel to effect 
the screen pop. When you receive an interaction from a customer channel, Oracle 
Universal Work Queue launches the appropriate application form and delivers the 
media information (call information) to the application. The application populates 
the form with customer or work information or both.

1.2.12 Interaction Blending
Interaction Blending mixes work from different customer channels according to 
service level rules such as the length of time a customer wait on an inbound call and 
the number of agents available to handle the interaction.  When Interaction 
Blending is enabled, a blending work source appears in the work selector.  Each 

Note: If the Profile Extension window appears and you do not 
know the teleset number, contact your supervisor.

The Phone Extension window will not appear if your user profile 
has been configured with the teleset number.
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time you request a blending work item, blending considers your skills and where 
they are most required.  

Interaction Blending through Oracle Universal Work Queue supports both inbound 
and outbound telephony and may blend across inbound classifications.  Once 
blending assigns you to a work source it tries to continue giving you work from that 
source; however, if you are needed on another work source, blending will move 
you.  For example, if a flood of inbound calls arrives around lunchtime, you may 
move from an outbound campaign to an inbound classification to help out; later 
blending may move you back to the outbound campaign. 

All work you perform on behalf of a customer can be divided into two categories:  
interactions and general work, sometimes called maintenance or off-line work.  An 
interaction is any work you perform when communicating across a customer 
channel such as an inbound or outbound telephone call, through e-mail or across a 
web collaboration session.   General work is any other work, especially work 
performed on behalf of a customer without a customer channel.

1.2.13 Refresh Strategy
In order for Oracle Universal Work Queue to provide up-to-date work information, 
including counts for all work and channel types, it mush refresh its information 
from the work source. 

Oracle Universal Work Queue provides a number of work refresh methods:

■ Full refresh

■ Node refresh

■ Sub-node refresh

The following table describes the refresh methods.

Note: You cannot perform node or sub-node updates from the 
cascading work selector. You may or may not be enabled to refresh 
nodes and sub-nodes through the work selector tree depending on 
how you are configured.
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The refresh for some work sources can be lengthy. Oracle Universal Work Queue 
supports the refresh strategies by providing the following refresh styles:

■ Automatic Refresh

■ Refresh on Login

■ Manual Refresh

The following table refresh styles for Universal Work Queue.

Refresh Style Description

Full Refresh Refreshes both the counts and contents of all work sources. 
Oracle Universal Work Queue may be configured for automatic 
or manual full fresh. See the table below that details refresh 
strategies.

Node Refresh This refresh method allows you to manually update any work 
source node counts and contents from the work selector tree.

Sub-node Refresh This method allows you to manually update any work source 
sub-node counts and contents from the work selector tree. 

Note: Because refreshing work source contents and counts takes a 
long time, it is "expensive", most users are configured for refresh on 
login or manual refresh. Typically users need to refresh at the start 
of their session, when they return from break, after a rush of work 
(for example after a number assignment notices), or after an hour or 
two of continuous work.

Refresh Style Description

Automatic Refresh A full refresh is performed when you request the next work 
item. This is not recommended since it can take some time for 
some nodes to refresh.

Refresh on Login Performs a refresh when you first log in. This is recommended, 
however it may delay the time to start working. After this first 
update, you must manually refresh work when appropriate.

Manual Refresh You must manually request a refresh when you need to obtain 
the current counts. 
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1.2.14 Work Assignment
Oracle Universal Work Queue can present all of your work. However, if you are not 
properly configured you may miss seeing some work. Work assignment explains 
how and why Oracle Universal Work Queue presents work items.

Work is organized into seeded nodes called work sources. In order to see an 
assigned work item, your supervisor or administrator must configure you to access 
the work source (node). Customer channels are special work sources that queue and 
deliver work when you request it. Application work items are assigned to you or a 
group through a number of means:

■ automatically through Assignment Manager and territories

■ manually when another user assigns a work item

■ automatically as the creator of the work item

Work may either be assigned to you or owned by you. Assignment means you are 
responsible for completing the task, ownership means you are responsible for 
managing the task and making sure it is completed. Only tasks may be assigned 
and tasks may also be owned. All other work items, such as service requests, leads 
and opportunities are owned.

Work may either be assigned to or owned directly by you, so you are personally 
responsible for it. Work may also be assigned to or owned by a group to which you 
belong. Oracle Universal Work Queue provides a full view of all work, whether 
owned or assigned directly to you or to a group.

1.2.15 Delivery of Work Items
Oracle Universal Work Queue delivers work to an application by executing a screen 
pop into an application form.  The method of delivery differs for application work 
items and customer channel work items.  For example, if a channel item does not 
contain complete information you may receive an intermediary search or decision 
screen.  For example, a call on behalf of an account with two customers will launch 
a decision screen where you can select which customer is calling.  A call from a pay 
phone may not include any customer information; in this case the application will 
screen pop a search screen and you will need to gather the customer information.

No matter whether you are working within an interaction or performing general 
work, Oracle Universal Work Queue provides tools that allow you to view, manage, 
organize, act upon, and control your work.  

The main Oracle Universal Work Queue components are:
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■ Agent Work Place  -- this allows you to view, manage, organize and act upon 
work.  The Work Places manages connections to all your work sources, allows 
you to navigate your work sources and individual work items, selecting, 
reviewing and organizing information to best suit your work methods.

■ IcWork Controller – this interaction center work controller allows you to control 
open interactions, imbeds media controllers such as the softphone, and presents 
real-time notice of important work item events. 

1.2.16 Navigating Oracle Universal Work Queue
This section provides you with information and shortcuts for navigating within 
Oracle Universal Work Queue.

Keyboard Navigation
In addition to being able to use the mouse to access and select work nodes and 
work items, you can accomplish the same tasks through the use of the keyboard.

Shortcut keys provide another means for navigating within the Oracle Universal 
Work Queue interface. See Menu Bar and Toolbar, Tools - Keyboard Shortcuts, 
Actions - Keyboard Shorts, and icWork Controller Keyboard Shortcuts for 
additional information. When using either the Tab key or Arrow keys to navigate 
within the interface, fields in which the information is predefined and available for 
selection only are denoted by a perforated line above and below the field. A 
blinking cursor appears in fields in which you are able to enter text.

The following table presents keyboard shortcuts for navigating in the Oracle 
Universal Work Queue interface.

Function Shortcut Key

Activate keyboard 
operation and selection 
mode

■ Left Arrow

■ Right Arrow

■ Shift + Shortcut Key

Activate keyboard 
operation and selection 
mode

Alt

Navigate between menu 
bar options

■ Left Arrow

■ Right Arrow

■ Shift + Shortcut Key
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Menu Bar and Toolbar
The menu bar and toolbar in Oracle Universal Work Queue provide several ways 
for you to quickly access features and navigate within the Oracle Universal Work 
Queue interface. You can perform the following:

■ switch responsibility

■ clear the current quick filter setting

■ reset quick filter settings to the default setting

■ refresh all work

■ reset an interaction

■ toggle the Oracle Universal Work Queue display between cascade and Hgrid 
view respectively

■ get work

■ stop media work

Tools - Keyboard Shortcuts The following table features keyboard shortcuts for 
functions available from the Tools option on the menu bar in Oracle Universal Work 
Queue.

Exit from a keyboard 
option

Esc

Exit from keyboard 
operation mode

Esc

Navigate between fields 
in the interface

Tab

Navigate between fields 
in the interface

■ Up Arrow

■ Down Arrow

■ Right Arrow

■ Left Arrow

Function Shortcut Key

Refresh All Work Shift + R

Reset Interaction Shift + S

Function Shortcut Key
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Actions - Keyboard Shortcuts The following table features keyboard shortcuts for 
functions available from the Actions option on the menu bar in Oracle Universal 
Work Queue. If media is enabled, media handling actions can be performed from 
the icWork Controller, including the ability to access action options through the use 
of keyboard shortcuts.

icWork Controller - Keyboard Shortcuts The following table features keyboard 
shortcuts for functions available from the Actions option on the menu bar in the 
icWork Controller.

Web Availability Shift + W

Clear Filter Shift + F

Default Filter Shift + D

Switch display to 
Cascade

Shift + C

Switch display to Hgrid Shift + H

Function Shortcut Key

Get Work Shift + G

Stop Media Shift + S

Function Shortcut Key

Next Media Shift + T

Stop Media Shift + M

Break Shift + K

Collapse Shift + L

Function Shortcut Key
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2
User Procedures

This chapter contains task-based procedures for using the product. The procedures 
will also appear in the product online help.

Topics include:

■ Getting Started with Oracle Universal Work Queue

■ Working on Application Work Items

■ Working on Media Work Items

■ Using the icWork Controller

■ Managing Sessions and Nodes

■ Managing Queues and Counts

■ Working with Quick Filters

See Also
■ Concepts

2.1 Getting Started with Oracle Universal Work Queue
The Universal Work Queue window displays your work items. Use this procedure 
to access the Universal Work Queue window.

Login
Oracle Forms Applications
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Responsibility
Customer Support or TeleSales Agent

Prerequisites
For application work:

■ You must be defined as an employee in Oracle Applications.

■ Your employee record must be linked to your Oracle Applications user account.

■ Oracle Universal Work Queue profile options must be configured for 
application work.

■ You must be defined as a CRM resource in Oracle Applications.

■ You must have the appropriate CRM roles in your CRM resource record.

■ You should identify the refresh strategy for the work item count in Universal 
Work Queue.

Work item counts may be refreshed when the Oracle Universal Work Queue 
window opens, after each delivery of a media work item, or manually (see 
Section 2.6.3, "Refreshing Work Counts"). The refresh strategy is set by your 
system administrator using the IEU: Desktop: UI: Refresh Style profile option. 
The refresh strategy may be the same for all agents in your interaction center or 
it may differ based on application, responsibility, or even user account.

For media work:

■ You must satisfy the prerequisites for application work.

■ Oracle interaction center information must be defined in your CRM resource 
record.

■ Oracle Universal Work Queue profile options must be configured for media 
work.

■ Oracle TeleSales or Oracle TeleService profile options must be configured for 
media work.

■ You should identify your phone extension. For example, if your phone number 
is 123-456-7890 and the length of internal extensions for your interaction center 
is set to five, then your phone extension is 67890.

You may have to enter it when you navigate to Oracle Universal Work Queue. If 
your system administrator has entered your phone extension in the IEU: 
Optional: Phone Extension profile option for your user account, then you will 
not have to enter your phone extension.
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Steps
1. Navigate to the Oracle Universal Work Queue window.

If you are enabled for application work only, then the Universal Work Queue 
window and the icWork Controller appear.

If you are enabled for media work, then the Phone Extension window may 
appear. 

2. If the Phone Extension window appears, enter the extension of your physical 
phone and then click OK. For example, if your phone number is 123-456-7890 
and the length of internal extensions for your interaction center is set to five, 
then enter 67890.

The Oracle Universal Work Queue window has two panes. The left pane lists 
the available work nodes and the count, or number, of work items in each node. 
The right pane displays the details of the work items in a selected node.

Work item counts may be refreshed when the Oracle Universal Work Queue 
window opens, after each delivery of a media work item, or manually. The 
refresh strategy is set by your system administrator. You may manually refresh 
work item counts at any time.

3. To manually refresh work counts, from the Tools menu, choose Refresh.

See Also
■ Section 2.2, "Working on Application Work Items"

Application Procedure

TeleService (Support) ■ In the Navigator window, on the Functions tab, choose 
Universal Work Queue.

TeleSales 1. In the Navigator window, on the Functions tab, choose 
eBusiness Center.

2. From the Tools menu, choose Universal Work Queue.

Note: If a phone extension is defined by the system administrator 
for your user account, then Universal Work Queue uses that phone 
extension for media work and does not display the Phone 
Extension window. 
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■ Section 2.3, "Working on Media Work Items"

■ Section 2.4, "Using the icWork Controller"

■ Section 2.5, "Managing Sessions and Nodes"

■ Section 2.6, "Managing Queues and Counts"

2.1.1 Universal Work  Queue Desktop Display Views
There are two ways in which the work selector can be displayed in Oracle Universal 
Work Queue; cascade view or Hgrid. The cascade view allows the work selector to 
be presented in a "drop-down" menu in while, Hgrid, which is commonly referred 
to as "tree view" presents the work selector in a linear format. 

The style that is available for use depends on how your facility is configured to 
display the work selector in Oracle Universal Work Queue.

2.1.2 Navigating Oracle Universal Work Queue
This section provides you with information and shortcuts for navigating within 
Oracle Universal Work Queue.

Keyboard Navigation
In addition to being able to use the mouse to access and select work nodes and 
work items, you can accomplish the same tasks through the use of the keyboard.

The following table presents keyboard shortcuts for navigating in the Oracle 
Universal Work Queue interface.

Function Shortcut Key

Activate keyboard 
operation and selection 
mode

■ Left Arrow

■ Right Arrow

■ Shift + Shortcut Key

Activate keyboard 
operation and selection 
mode

Alt

Navigate between menu 
bar options

■ Left Arrow

■ Right Arrow

■ Shift + Shortcut Key
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Menu Bar and Toolbar
The menu bar and toolbar in Oracle Universal Work Queue provide several ways 
for you to quickly access features and navigate within the Oracle Universal Work 
Queue interface. You can perform the following:

■ switch responsibility

■ clear the current quick filter setting

■ reset quick filter settings to the default setting

■ refresh all work

■ reset an interaction

■ toggle the Oracle Universal Work Queue display between cascade and Hgrid 
view respectively

Exit from a keyboard 
option

Esc

Exit from keyboard 
operation mode

Esc

Navigate between fields 
in the interface

Tab

Navigate between fields 
in the interface

■ Up Arrow

■ Down Arrow

■ Right Arrow

■ Left Arrow

Note:  Shortcut keys provide another means for navigating within 
the Oracle Universal Work Queue interface. See Menu Bar and 
Toolbar, Tools - Keyboard Shortcuts, Actions - Keyboard Shortcuts, 
and icWork Controller - Keyboard Shortcuts for additional 
information. When using either the Tab key or Arrow keys to 
navigate within the interface, fields in which the information is 
predefined and available for selection only are denoted by a 
perforated line above and below the field. A blinking cursor 
appears in fields in which you are able to enter text. 

Function Shortcut Key
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■ get work

■ stop media work

Tools - Keyboard Shortcuts The following table features keyboard shortcuts for 
functions available from the Tools option on the menu bar in Oracle Universal Work 
Queue.

Actions - Keyboard Shortcuts The following table features keyboard shortcuts for 
functions available from the Actions option on the menu bar in Oracle Universal 
Work Queue. If media is enabled, media handling actions can be performed from 
the icWork Controller including the ability to access action options through the use 
of keyboard shortcuts. The following is a list of the keyboard shortcuts available 
from the icWork Controller.

2.2 Working on Application Work Items
Use the following procedures to manage application work items.

Tasks
You can perform the following tasks:

■ Browse Application Work Items

Function Shortcut Keys

Refresh All Work Shift + R

Reset Interaction Shift + S

Web Availability Shift + W

Clear Filter Shift + F

Default Filter Shift + D

Switch display to 
Cascade

Shift + C

Switch display to Hgrid Shift + H

Function Shortcut Keys

Get Work Shift + G

Stop Media Shift + S
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■ Request the Next Priority Application Work Item

■ Reschedule Application Work Items

■ Stop the Delivery of Work Items

2.2.1 Browsing Application Work Items
The individual application (non-media) work item nodes allow you to browse lists 
of individual work items and select a specific item to work on.

Use this procedure to browse and select a work item.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. From the work selector in the agent workplace in Universal Work Queue, select 

an application work source (node).

The work items are listed in the detail pane.

2. Select a work item from the detail pane.

3. Click Get Work.

Note: If necessary, expand the application node to access the work 
item nodes. 

Note: Whether you using the icWork Controller or accessing work 
items from agent workplace, use the Get Work function to retrieve 
work items. You may also double-click on the work item in the 
work selector to select the work item.
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The appropriate application window will open and will present the details of 
the work item.

4. When you finish, save your work in the application window.

5. To select another work item, select the work item and then click Get Work.

Guidelines
The following table lists the application work nodes and the application window 
that opens when you work on an item in the node.

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Hiding Work Counts

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

Work Node Application

Tasks Task Manager, TeleSales, or TeleService

Service Request Service Requests (TeleService)

Escalations Escalations (CRM Foundation)

My Leads Leads Center (TeleSales)

My Opportunities Opportunity Center (TeleSales)

Forecasts

Quotes TeleSales

Delinquencies Collections

Marketing Lists TeleSales

Broken Promises Collections

Dunning Collections
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■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

2.2.2 Requesting the Next Priority Application Work Item
Use this procedure to request the next priority work item in your WorkList.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. From the icWork or agent workplace, select the Next Worklist Item menu 

option or toolbar icon. 

The next item in the worklist appears in the detail pane.

2.2.3 Rescheduling a Work Item
Use this procedure to reschedule a work item in your WorkList.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. From the icWork or agent workplace, select the Reschedule Worklist Item 

menu option or toolbar icon. 
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2.2.4 Stopping Work Item Delivery
Use this procedure to stop the delivery of application work items.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. From the icWork or agent workplace, select the Stop Worklist menu option or 

toolbar icon. 

See Also
■ Refreshing Work Counts

■ Handling Inbound Telephone Calls

■ Working on Outbound Campaigns

■ Returning Web Callbacks

■ Managing Blended Calls

■ Viewing Your E-mail Workload

■ Modifying Your Node Order

2.3 Working on Media Work Items
Use the following procedures to handle media work items.

Tasks
■ Handling Inbound Telephone Calls

■ Working on Outbound Campaigns

■ Returning Web Callbacks
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■ Managing Blended Calls

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

■ Resetting an Interaction

2.3.1 Handling Inbound Telephone Calls
When the interaction center receives an inbound call, the call is classified and then 
routed to a pool of one or more agents. Your Inbound Telephony node displays the 
number of inbound calls that have been routed to agent groups to which you 
belong.

Inbound call counts are categorized by call classification. Only call classifications 
with available inbound calls are listed, even though you may be eligible to answer 
calls in other call classifications.

Other agents may be eligible to answer calls in a call classification. The inbound call 
count for a call classification will decrease when another agent answers a call. When 
the last remaining call for a call classification is answered, the call classification will 
disappear from your inbound telephony node.

Use this procedure to indicate that you are ready to receive inbound calls.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. In the Universal Work Queue window, expand the Media node and click 

Inbound Telephony.

Inbound calls counts are categorized by call classification in the detail pane. 
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2.3.1.1 To Start Receiving Inbound Calls
To start receiving inbound calls:

1. Click a call classification.

2. Click Get Work.

When the call is delivered, Oracle Universal Work Queue and the application 
execute a screen pop. Oracle Universal Work Queue launches the appropriate 
application window based on the classification action setting and passes the call 
information. The application opens the work item and displays the work 
details.

3. Work within the application during your customer interaction. At the end of the 
call, press Release on the softphone to hang up the call. 

If there is after-call work, such as completing an order or sending collateral, 
complete it within the application. 

When you have completed all after-call work, you may wrap up and status the 
interaction.

a. Automatically status

b. Manual (wrap up)

2.3.1.2 To End an Inbound Call
To end the call and complete your work in the current interaction:

1. Press Release on the softphone to hang up the call.

2. Complete your work.

3. Wrap up the interaction.

2.3.1.3 To End the Interaction and Request Another in the Same Classification
To manually wrap up an interaction and request another call of the same 
classification:

1. Select a call outcome.

Note: This only applies to manually wrapping up an interaction. 
You do not have to click Next Media in the icWork Controller 
toolbar. Automatic status will end the interaction.
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2. Complete all media work.

3. Click End Interaction in the application window.

You are now ready to receive inbound calls of the same classification.

2.3.1.4 To End an Interaction and Suspend Call Delivery
To stop working the inbound classification and suspend call delivery:

1. Press Stop Media before ending the interaction.

2. Select a call outcome.

3. Complete all media work.

4. Click End Interaction in the application window.

2.3.1.5 To Change Customer Channels
To change customer channels:

1. Press Stop Media before ending the interaction.

2. Select a call outcome.

3. Complete all media work.

4. Select a new customer channel.

2.3.1.6 To Request Calls of a Different Classification
To stop working the inbound classification and suspend call delivery:

1. Press Stop Media before ending the interaction.

2. Select a call outcome.

3. Complete all media work.

Note: If you are using session tracking, you may request a break 
and suspend inbound calls.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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4. Click End Interaction in the application window.

5. Select a different inbound call classification or an outbound campaign from the 
agent workplace in Oracle Universal Work Queue.

See Also
■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Hiding Work Counts

■ Managing Blended Calls

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.3.2 Working on Outbound Campaigns
Use this procedure to start making outbound calls for a campaign.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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Prerequisites
None

Steps
1. From the agent workplace, select the media node and the outbound campaign 

sub-nodes using the Hgrid (tree) or cascading work selector.

Outbound calls counts are categorized by campaign in the detail pane.

2.3.2.1 To Start Making Outbound Calls
To start making outbound calls:

1. Select a campaign.

2. Click Get Work.

The appropriate application window opens and displays the details of the work 
item.

3. If necessary, place the call using the softphone.

2.3.2.2 To End an Outbound Call
To end the outbound call and complete your work in the current interaction:

1. Press Release on the softphone to hang up the call.

2. Complete your work.

3. Wrap up the interaction.

2.3.2.3 To End the Interaction and Request Another of the Same Campaign
To end the interaction and request another interaction for the same campaign:

1. Select a call outcome.

2. Complete all media work.

3. Click End Interaction in the application window.

You are now ready to receive calls of the same classification.

Note: You do not have to click Next Media in the icWork 
Controller toolbar. Automatic status will end the interaction.
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2.3.2.4 To End the Outbound Interaction and Suspend Call Delivery
To end the outbound interaction and suspend call delivery:

1. Press Stop Media before ending the interaction.

2. Select a call outcome.

3. Complete all media work.

4. Click End Interaction in the application window.

2.3.2.5 To Change Outbound Campaigns
To handle calls for a different campaign:

1. Press Stop Media before ending the interaction.

2. Select a call outcome.

3. Complete all media work.

4. Click End Interaction in the application window.

5. Select a different campaign.

6. Click Get Work.

See Also
■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

Note: If a call is on its way to you when you suspend call delivery, 
then you will receive one last call before your call delivery is 
suspended.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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■ Modifying Your Node Order

■ Refreshing Work Counts

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.3.3 Returning Web Callbacks
While browsing your company’s web pages, customers may request a callback to 
answer an immediate question. This callback request is relayed through the 
interaction which queues and routes the call request as if it were an inbound call. 
When an agent is available to handle the callback request, interaction center dials 
the customer and Oracle Universal Work Queue delivers the call just as it does 
inbound calls.

Use this procedure to return and handle web callbacks.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. In the Universal Work Queue window, expand the Media node and click Web 

Callback.

Web callback counts are categorized by call classification in the detail pane. 
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2.3.3.1 To Start Returning Web Callbacks
To start returning web callbacks:

1. Select a campaign.

2. Click Get Work.

The appropriate application window opens and displays the details of the work 
item.

3. If necessary, place the call using the softphone.

2.3.3.2 To End the Web Callback
To end the web callback call and complete your work in the current interaction:

1. Press Release on the softphone to hang up the call.

2. Complete your work.

3. Wrap up the interaction.

2.3.3.3 To End the Web Callback and Request Another of the Same Type
To end the web callback and request another call of the same type:

1. Select a call outcome.

2. Complete all media work.

3. Click End Interaction in the application window.

You can now ready to receive calls of the same classification.

2.3.3.4 To End the Web Callback and Suspend Call Delivery
To end the web callback and suspend call delivery:

1. Press Stop Media before ending the interaction.

2. Select a call outcome.

3. Complete all media work.

4. Click End Interaction in the application window.

Note: You do not have to click Next Media in the icWork 
Controller toolbar. Automatic status will end the interaction.
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2.3.3.5 To Request Calls for a Different Classification
To request calls for a different classification:

1. Press Stop Media before ending the interaction.

2. Select a call outcome.

3. Complete all media work.

4. Click End Interaction in the application window.

5. Select a different call classification.

6. Click Get Work.

See Also
■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Restoring Queues

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

Note: If a call is on its way to you when you suspend call delivery, 
then you will receive one last call before your call delivery is 
suspended.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.3.4 Managing Blended Calls
Oracle Universal Work Queue handles service level blending and priority source 
blending. When media work blending is enabled, the Media node is replaced with a 
Blended node.

Use this procedure to start handling blended calls.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. In the Universal Work Queue window, click Blended.

Media work is categorized by type in the detail pane. 

2. To start handling blended calls, click a node and then click Get Work.

The appropriate application window opens and displays the details of the work 
item.

3. If you want to end the call and complete your work in the current interaction, 
then do the following:

a. Click Release on the softphone to hang up the call.

b. Click Wrap Up in the application window.

c. Complete your work.

Note: If you are configured for priority source blending, you must 
select an outbound campaign order at startup.
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4. If you want to end the interaction and request another call from the Blended 
node, then do the following:

a. Click End Interaction in the application window.

b. Select a call outcome.

You are now ready to receive a call.

5. If you want to end the interaction and suspend call delivery, then do the 
following:

a. Click Stop Media in the icWork Controller or Oracle Applications toolbar.

b. Click End Interaction in the application window.

c. Select a call outcome.

6. If you want to request calls of a different media type, then do the following:

a. Click Stop Media in the icWork Controller or Oracle Applications toolbar.

b. Click End Interaction in the application window.

c. Select a call outcome.

d. Click a different call classification and then click Get Work in the Oracle 
Universal Work Queue window.

Note: You do not have to click Next Media in the icWork 
Controller toolbar.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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See Also
■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.3.5 Viewing Your Email Workload
You cannot launch Oracle EMail Center from Oracle Universal Work Queue. You 
can only view your e-mail workload. To launch Oracle eMail Center, you must go to 
the HTML Login URL and log on as an eMail Center agent.

Use this procedure to view your e-mail work load.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None
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Steps
1. In the Universal Work Queue window, expand the Media node and click an 

e-mail node.

A summary is displayed in the detail pane.

See Also
■ Browse Application Work Items

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Hiding Work Counts

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Using the Softphone in the icWork Controller

2.3.6 Resetting an Interaction
Use this procedure to reset an interaction.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None
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Steps
1. From the Tools menu, choose Reset Interaction.

You cannot use the Oracle Universal Work Queue window until after the 
interaction is reset.

See Also
■ Refreshing Work Counts

■ Restoring Queues

■ Showing Work Counts

2.4 Using the icWork Controller
Use the following procedures to operate the softphone.

Tasks
You can perform the following tasks:

■ Using the Softphone in the icWork Controller

■ Managing Notices from the icWork Controller

2.4.1 Using the Softphone in the icWork Controller
The softphone is displayed in the Phone tab of the icWork Controller. The color of 
the softphone line buttons (for example, Line 1) indicate the status of the line. Use 
the following table to interpret the color.

Use the following procedure to operate the softphone.

Login
Oracle Forms Applications

If the line color is... Then the line is...

Gray Selected

Green In use

Yellow Ringing
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Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. In the icWork Controller, click the Phone tab.

Use the following table to find procedures for operating the softphone.

Note: For the Lucent Avaya switch with Dialogic CT-Connect 
middleware, softphone auto-hold is enabled. Any current call will 
be placed on hold when you click another line button. To hang up 
the current call, click Release.

If softphone auto-hold is not enabled, then the current call will end 
when you click another line button. To put any current call on hold, 
you must click Hold.

To... Do this...

Answer a call Click a yellow line button (for example, Line 1).

Note: If the switch is set for auto-hold, then 
clicking another line button will place any 
current call on hold.

If the switch is not set for auto-hold, then any 
current call, not on hold, will end when you 
click another line button.
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Place a call 1. Click a gray line button (for example, Line 
1).

Note: If the switch is set for auto-hold, then 
clicking another line button will place any 
current call on hold.

If the switch is not set for auto-hold, then 
any current call, not on hold, will end when 
you click another line button.

2. Click the number buttons, type the 
numbers using your keyboard, or select a 
previously entered number.

3. Click Dial.

Enter a response to a voice prompt 1. Click the number buttons, type the 
numbers using your keyboard, or select a 
previously entered number.

2. Click Dial.

Place a call on hold Click Hold.

The line button for a holding line blinks green.

Note: If the switch is set for auto-hold, then 
clicking another line button (for example, Line 
1) will also place the current call on hold.

If the switch is not set for auto-hold, then any 
current call, not on hold, will end when you 
click another line button.

Remove a call from hold The line button for a holding line blinks green.

If only one line is holding, Click Hold.

If multiple lines are holding, click the line 
button (for example, Line 1) for the holding line.

Hang up a call Click Release or click another line button (Line 
1)

Note: If the switch is set for auto-hold, then 
clicking another line button will place the 
current call on hold and not release the call. You 
must return to the line and then click Release.

If the switch is not set for auto-hold, then any 
current call, not on hold, will end when you 
click another line button.

To... Do this...
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Transfer a call To transfer a call with the softphone on a 
non-Aspect switch:

1. With the caller on the line, dial the number 
to which you want to transfer the call.

2. Click Transfer.

The call is put on hold and the number is 
dialed.

3. When the call is answered, click Transfer 
again.

To transfer a call with the softphone on an 
Aspect switch:

1. Click Hold to place the call on hold.

2. Select a gray line button.

3. Dial the number to which you want to 
transfer the call.

4. When the call is answered, click Transfer.

Conference a call To conference a call with the softphone on a 
non-Aspect switch:

1. With the caller on the line, dial the number 
that you want to add to the conference call.

2. Click Conference.

The call is put on hold and the number is 
dialed.

3. When the call is answered, click 
Conference again.

To conference a call with the softphone on an 
Aspect switch:

1. Click Hold to place the call on hold.

2. Select a gray line button.

3. Dial the number that you want to add to 
the conference call.

4. When the call is answered, click 
Conference.

Indicate readiness for calls. Click Next Call.

To... Do this...
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See Also
■ Browse Application Work Items

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Viewing Your E-mail Workload

■ Ending Your Oracle Universal Work Queue Session

Suspend calls. Click Cancel.

Note: If a call is already on its way to you before 
you click Cancel, then you will receive one 
more call before your calls are suspended.

Request the next priority application 
work item from your WorkList

Click Next Worklist Item.

Take a break 1. Click Break.

2. Select a break reason.

3. Click OK.

To... Do this...
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2.4.2 Managing Notices from the icWork Controller
Notices are displayed in the Notices tab of the icWork Controller. Use the following 
procedure to manage your notices.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. In the icWork Controller, click the Notices tab.

The following table describes the actions that you can perform in the Notices 
tab.

See Also
■ Browse Application Work Items

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

To... Do this...

Navigate through your notices Click the arrow buttons.

Acknowledge receipt of a new notice Click ACK.

Clear a notice from the Notices tab Click CLR.

Filter your notices Select a filter from the Message Filter list.

Check for new notices Click Refresh.
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■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.5 Managing Sessions and Nodes
Use the following procedures to manage sessions and nodes.

Tasks
You can perform the following tasks:

■ Modifying Your Node Order

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Ending Your Oracle Universal Work Queue Session

2.5.1 Modifying Your Node Order
The Work Selector provides an overview of your workload; it is organized into 
work source nodes by application work type (such as Tasks, Leads, Service 
Requests, etc.) and customer channel source (such as Inbound Telephone calls, 
Outbound Campaigns, eMail, etc.)  Some nodes comprise more specific work item 
types such as “My Leads” or “My Teams Leads”.   Most nodes are further 
segmented into sub-nodes by attributes, such as application work type status, age 
or ownership.  Some nodes have several sub-node segmentation tiers.

The Hgrid (tree) work selector displays along the left side of the agent workplace.  It 
provides a quick overview of workload and its organization.  It also enables you to 
turn counts on and off and to control the display and order of nodes. 
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The cascading work selector displays as a drop down menu at the top left of the 
agent workplace, just below the menu bar and toolbar.  It is more compact and 
affords a great display area for the work summary panel.

Use the Switch work selector control or menu option to toggle between the tree and 
cascading work selector display styles.

Use this procedure to change the order in which work nodes appear in the work 
selector in Oracle Universal Work Queue.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Preferences

Prerequisites
None

Steps
1. Choose Edit > Preferences > Profile.

The Personal Profile Values window appears.

2. Choose View > Query by Example > Enter (F11).

3. In the Profile Name field, enter IEU%.

4. Choose View > Query by Example > Run (Ctrl + F11)

The Universal Work Queue personal profile values appear.

5. In the IEU: Queue Order: <nodename> profile options, select a number between 
1 through 26. 

Nodes are displayed in ascending order in the Oracle Universal Work Queue 
window.

See Also
■ Browse Application Work Items

■ Customizing Queues
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■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.5.2 Taking a Break from Your Oracle Universal Work Queue Session
Use this procedure to take a formal break from your Oracle Universal Work Queue 
session.

 You may only request a break if you are configured for session tracking.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Note: You may only request a break if you are configured for 
session tracking.
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Prerequisites
None

Steps
1. In the icWork Controller toolbar or Actions menu, click Break.

2. In the Break Reason window, select the reason for the break and then click OK.

3. To resume work, do one of the following:

■ From the Oracle Universal Work Queue window, select a node and then 
click Get Work.

■ In the icWork Controller or the Oracle Applications toolbar, click Next 
Worklist Item to receive the next priority application work item.

■ In the icWork Controller toolbar, click Next Media to handle the next media 
work item of the current type.

See Also
■ Browse Application Work Items

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller
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■ Viewing Your E-mail Workload

2.5.3 Ending Your Universal Work Queue Session
Use this procedure to close the Universal Work Queue window and end your 
Universal Work Queue session.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. Close the Oracle Universal Work Queue window (File > Close Form) or exit 

from Oracle Applications (File > Exit Oracle Applications).

If session history logging is enabled, the Break Reason window will appear.

2. In the Break Reason window, select the break reason and then click OK.

See Also
■ Browse Application Work Items

■ Customizing Queues

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues
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■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.6 Managing Queues and Counts
Use the following procedures to manage queues and counts.

Tasks
You can perform the following tasks:

■ Customizing Queues

■ Restoring Queues

■ Refreshing Work Counts

■ Hiding Work Counts

■ Showing Work Counts

2.6.1 Customizing Queues
Use this procedure to customize the display and order of work queues.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Note: Use the switch work selector control to toggle between the 
Hgrid (tree) and cascade work selectors.
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Prerequisites
Oracle Universal Work Queue must be configured to display the work selector 
using the Hgrid (tree) work selector. In addition, your user profile must also be set 
up to view the work selector in Hgrid selector mode.

Steps
1. In the Oracle Universal Work Queue window, right-click on Queue.

The Queue Control window appears.

The following table describes the options available for you to select.

2. Choose Customize Queues.

The Customize Queues window appears.

3. Select the node(s) to exclude or display.

You can move nodes between those excluded or displayed by using the 
appropriate button.

4. Select the appropriate button to sort the order the nodes in the work queue. You 
can sort the nodes in ascending or descending order.

5. Click OK.

See Also
■ Browse Application Work Items

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

To... Select this option...

Refresh counts Refresh

Customize the queue Customize

Restore queue settings Restore Queues

Hide work counts Hide Counts
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■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.6.2 Restoring Queues
Use this procedure to restore the display and order of work queues.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
You must be configured to customize work queues.

Steps
1. In the Oracle Universal Work Queue window, right-click on Queue.

The Queue Control window appears.

2. Choose Restore Queues.

The Oracle Universal Work Queue window will refresh and the queue order 
will be restored to the default setting.

See Also
■ Browse Application Work Items
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■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.6.3 Refreshing Work Counts
You can refresh individual work node counts using the Hgrid (tree) work selector. 
Work item counts may be refreshed when the Oracle Universal Work Queue 
window opens, after each delivery of a media work item, or manually. You may 
manually refresh work item counts at any time.

The refresh strategy is set by your system administrator. The refresh strategy may 
be the same for all agents in your interaction center or it may differ based on 
application, responsibility, or even user account.

Use this procedure to manually refresh work item counts.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent
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Prerequisites
None

Steps
1. From the Tools menu, choose Refresh.

You cannot use the Oracle Universal Work Queue window until after the count 
is refreshed.

See Also
■ Browse Application Work Items

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.6.4 Hiding Work Counts
Use this procedure to hide node counts in the Oracle Universal Work Queue 
window.
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Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
Oracle Universal Work Queue must be configured to display the work selector 
using the Hgrid (tree) work selector. In addition, you must be configured to 
customize queues. Use the switch work selector control to toggle to the Hgrid (tree) 
work selector.

Steps
1. In the Oracle Universal Work Queue window, right-click on Queue.

The Queue Control window appears.

2. Select Hide Counts.

The Oracle Universal Work Queue window will refresh and counts for the work 
nodes will not appear.

See Also
■ Browse Application Work Items

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Showing Work Counts
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■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.6.5 Showing Work Counts
Use this procedure to show node counts in the Oracle Universal Work Queue 
window.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
Oracle Universal Work Queue must be configured to display the work selector 
using the Hgrid (tree) work selector. In addition, you must be configured to 
customize queues. Use the switch work selector control to toggle to the Hgrid (tree) 
work selector.

Steps
1. In the Oracle Universal Work Queue window, right-click on Queue.

The Queue Control window appears.

2. Deselect Hide Counts.

The Oracle Universal Work Queue window will refresh and all counts for the 
work nodes will appear.

See Also
■ Browse Application Work Items

■ Customizing Queues

■ Ending Your Oracle Universal Work Queue Session

■ Handling Inbound Telephone Calls
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■ Hiding Work Counts

■ Managing Blended Calls

■ Managing Notices from the icWork Controller

■ Modifying Your Node Order

■ Refreshing Work Counts

■ Request the Next Priority Application Work Item

■ Restoring Queues

■ Returning Web Callbacks

■ Taking a Break from Your Oracle Universal Work Queue Session

■ Working on Outbound Campaigns

■ Using the Softphone in the icWork Controller

■ Viewing Your E-mail Workload

2.7 Working with Quick Filters
The quick filter feature allows you to sort the presentation of work items in Oracle 
Universal Work Queue. Each quick filter column is identified by a field label which 
indicates the sorts or filters available. Within each column is a list of variables from 
which you can select. 

When you first enter the Oracle Universal Work Queue interface to access and 
process work items, the default quick filters appear. These default filters are set by 
your system administrator. You can modify the sort order of the work items, 
prioritizing work items based on your priorities or work objectives. For example, 
sorting tasks that are assigned to you or due today. Upon determining the filter 
criteria, you will need to apply the filters using the Apply Filter button located to 
the right of the filter columns.

Use the following procedures to work with quick filters.

Note:  Your system administrator manages the filter columns for 
each work provider. There is a default quick filter for each work 
provider node.
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Tasks
You can perform the following tasks:

■ Applying Quick Filters

■ Clearing Quick Filters

■ Restoring the Default Quick Filter

2.7.1 Applying Quick Filters
Use this procedure to apply quick filters to your work view.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
Quick filters must be defined for the work provider and enabled and the 
appropriate profile options must be set.

Steps
1. In the Oracle Universal Work Queue agent workplace, use the drop-down filter 

parameters to select quick filter values.

2. Click the In the Oracle Universal Work Queue window, select the Apply Filter 
button.

The work summary panel will refresh and display work items that qualify for 
the new filter.

Note: The Clear Filter option is available from the Tools option on 
the menu bar and from a button on the toolbar.
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See Also
■ Working with Quick Filters

■ Clearing Quick Filters

■ Restoring the Default Quick Filter

2.7.2 Clearing Quick Filters
Use this procedure to clear the quick filters that you have applied.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
Quick filters must be defined for the work provider and enabled and the 
appropriate profile options must be set. You must have applied quick filters other 
than the default filters.

Steps
1. In the Oracle Universal Work Queue window, select the Clear Filter option.

Note: If there are no work items that meet the filter criteria, no 
work will display in the work detail area. The filter will only 
applies to the current session. When you end your session, the 
filters setting revert to the default settings. You will notice when 
you log in back in to the Oracle Universal Work Queue agent 
workplace, the default settings for the quick filters have been 
applied.

Note: The Clear Filter option is available from the Tools option on 
the menu bar and from a button on the toolbar.
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The filters that you have applied will clear and the work items in the work 
summary panel in Oracle Universal Work Queue will appear in their original 
view.

See Also
■ Working with Quick Filters

■ Applying Quick Filters

■ Restoring the Default Quick Filter

2.7.3 Restoring the Default Quick Filter
Use this procedure to restore the default quick filter to your work view.

Login
Oracle Forms Applications

Responsibility
Customer Support or TeleSales Agent

Prerequisites
Quick filters must be defined for the work provider and enabled and the 
appropriate profile options must be set.

Steps
1. In the Oracle Universal Work Queue window, select the Clear Filter option.

The filters that you have applied will clear and the work items in the work 
summary panel in Oracle Universal Work Queue will appear in their original 
view.

See Also
■ Working with Quick Filters

■ Applying Quick Filters

Note: The Clear Filter option is available from the Tools option on 
the menu bar and from a button on the toolbar.
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■ Clearing Quick Filters
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